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Canopus eigene Technologie

DDV Storm 2 gehört zu den weltweit leistungsstärksten Multi-Track Echtzeit-Videoschnittsystemen. In DV 
Storm 2 sind die Canopus eigene Technologie (DV Storm 2 verfügt über beste DV- und MPEG-Qualität), 
bahnbrechende Echtzeitleistungsfähigkeit und eine professionelle, stabile und zuverlässige Studio-Ausstattung 
kombiniert. 

Im Gegensatz zu Schnittsystemen anderer Anbieter ermöglicht DV Storm 2 die Integration von unbegrenzt 
vielen Echtzeit-Videofiltern, Echtzeit-Titel- und -Grafikspuren gleichzeitig. Diese Leistungsfähigkeit und 
die Erweiterungsmöglichkeiten werden durch die Canopus eigene skalierbare Technologie ermöglicht. 
Die 1998 von Canopus erstmals veröffentliche eigene skalierbare Technologie erweitert automatisch die 
Echtzeitfunktionen der DV Storm 2 beim Einsatz einer größeren CPU. Skalierbarkeit gewährleistet eine lange 
Produkt-Lebensdauer.

Bis heute, gibt es kein anderes System, dass diese Skalierbarkeit bietet. 

No Limits – Echtzeitvideoschnitt

> 5 Videospuren gleichzeitig
> unbegrenzte Echtzeit Titel und Grafikspuren gleichzeitig
> 30 Echtzeit-Videofilter
> 7 Echtzeit Audiofilter
> Perspektive / 3D Bild-im-Bild
> Uneingeschränkte Kombinationen der oben erwähnten Funktionen gleichzeitig
> 26 Echtzeit 2D und 3D Übergangsgruppen mit Hunderten von Presets
> Echtzeit DV und analoge Ausgabe
> Komplett YUV-Schnitt und –Verarbeitung

> 5 Echtzeit-Videospuren
> 4 Bild-im-Bild-Spuren inkl. Zoom
> Echtzeit Blur auf dem Hintergrund
      

> 30 Echtzeit Titel und Grafikspuren 
mit bewegten und transparenten 
Effekten 

   

Realtime Production Studio



2 3

DVD-Authoring
> DV Storm 2 vereinigt den technisch ausgereiften MPEG-1 & 2 Encoder für eine hochqualitative Archivierung 

von Videodaten und eine professionelle DVD-Publikation.

> Echtzeit MPEG 1 & 2 Capturing von analoger oder DV Quelle

> Timeline Export nach MPEG 1 & 2 mit Anwender-spezifisch definierbaren Presets für DVD, SVCD & VCD

> Encodierung zu CBR, VBR, Program Stream, Elementary Stream, MP @ ML DVD-kompatibles Encodieren 

> MpegCutter Anwendung: Schnitt, Kürzen und Re-Export von MPEG-Clips

> AV Splitter Anwendung: Erstellt Elementary Stream-Dateien von Program Stream-Dateien und trennt 
Audio und Video

> Mpeg Re-Encoder: rekonvertiert MPEG-Dateien mit hoher Bitrate zu Dateien mit niedrigeren Bitraten in 
höchster Geschwindigkeit unter Nutzung der Hardware-MPEG-Encodierung

> Mpeg Explorer: Bietet eine detaillierte Ansicht aller MPEG-Dateien eines bestimmten Ordners

> Ulead DVD Workshop: Professionelle DVD Autorensoftware 

Neue Echtzeit-Filter
> Spiegel

> Rasterscroll 

> Tunnel-Sicht

> Loopslide

> Strobe

> Weißabgleich / Schwarzabgleich Filter

Xplode für DV Storm und 3DRT-II – Software für Echtzeit 
2D & 3D Übergänge
> Erstellt einzigartige, atemberaubende und hochprofessionelle Videoeffekte

> 3D Perspektive Bild-im-Bild / Pan & Zoom 

Video-Ausgabe Plug In’s
> After Effects 5.x

> Photoshop 7.x

> Lightwave 3D 7.0

Canopus DV Capture
> Single Pass Szenenerkennung und Capturing / Batchcapture-Möglichkeit

> Capturing von 3 Streams gleichzeitig von zahlreichen DV Quellen. 
(Benötigt zusätzlich IEEE 1394 Karte)

AVI2 Unterstütztung
> Beschleunigte Ausgabe von der Timeline (5-fache Geschwindigkeit)

> Import von AVI2 Dateien in die Storm Edit- oder Premiere-Timeline

> Capturing von 3 Streams 
gleichzeitig

Leistungsstarke neue Funktionen der DVStorm2 
Umfangreiche neue MPEG-Funktionen und fortschrittliches 
DVD-Authoring
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Fortschrittliche Echtzeit Videofilter

DV Storm 2 bietet einzigartige und leistungsstarke Canopus Echtzeit-Videofilter

30 Echtzeit Videofilter
> Anti-flicker

> Blenden-Effekte

> Blur

> Chromakey 

> Chrominance (Farbgebung)

> Farbkorrektur

> Kombinations-Effekte

> Emboss

> Hochqualitativer Blur

> Loopslide

> Luminance Key

> Matrix

> Spiegel

> Monochromatic

> Mosaic

> Motion Blur

> Noise

> Old Movie

> Pencil Sketch

> Bild-im-Bild

> Raster Scroll

> Region

> Sharp

> Soft Focus

> Solid Color

> Speed Control (-10.000% bis +10.000%)

> Strobe

> Tunnel Sicht

> Variable Geschwindigkeitskontrolle

> Weißabgleich / Schwarzabgleich

> Bereichsfilter 
     > Blur

     > Farbkorrektur 

> Originalvideo > Chrominance Filter 

> Originalvideo 

> Originalvideo > Motion Blur

> Originalvideo > Tunnel-Sicht 
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Kombination von Echtzeitfiltern

  

Blenden-Effekte

Echtzeit-Filter für bewegte Titel
Canopus DV Storm 2 verfügt über unbegrenzt 
viele Echtzeit Titel- und Grafikspuren gleichzeitig. 
Erstellen Sie umfangreiche Titel mit Dutzenden von 
Text- und Grafiklayern in Echtzeit. Die Bewegungs- 
und Transparenzkontrolle ermöglichen, dass jeder 
Layer verschieden sein kann. Die Filter für bewegte 
Titel beinhalten Blur, Dissolve, Slide In und Out, 
Wipe In und Out und Laser In und Out u.v.m.

> Kombinations-Effekte
 > Bereichsfilter
 > Farbkorrektur
 > Soft Focus
 > Emboss
 > Pencil Sketch

> Kombinations-Effekte
 > Bereichsfilter
 > Farbkorrektur
 > Soft Focus
 > Emboss
 > Pencil Sketch
 > Kreisrunder Bild-im- 
  Bild-Effekt
 > Chromakey

> Blur
      

> Monochrome     > Chrominance, um die 
Farbe des Autos zu 
verändern

 

> Pencil Sketch
      

> 15 Echtzeit Titel- 
und Grafikspuren

> Old Movie &
 Farbkorrektur

> Old Movie & 
 Farbkorrektur &  
 Bereichsfilter, um 16:9  
 Format zu erhalten 

> Kombinations-Effekte
 > Bereichsfilter
 > Farbkorrektur
 > Emboss
 

> Originalvideo 

> Originalvideo > Old Movie 

Kombinations- und Blenden-Effektfilter
Es können grenzenlos viele Videofilter kombiniert und mit Blendeneffekten versehen werden. Die Canopus 
skalierbare Technologie erlaubt eine Aneinanderreihung von Videofiltern auf bis zu 5 Videospuren in Echtzeit.
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Echtzeit Chroma- und Lumakey

Die Funktion Chroma- und Lumakey ermöglicht Editoren, Teile ihres 
Videos transparent zu gestalten. Gekeyte Clips können über andere Clips 
gelegt werden, um den Effekt zu erzielen, dass eine Person vor einem 
Hintergrundvideo platziert wird. Bei Canopus erfolgt die Verarbeitung 
von Echtzeiteffekten im YUV-Farbraum mit einer Samplingrate von 4:2:
2. Das Resultat hieraus ist ein sauberes Chroma- und Lumakeying ohne 
Kompressions-Artefakte an den Kanten des gekeyten Objektes, die man bei 
einem Keying im RGB-Farbraum einfach in Kauf nehmen muss. 

Chromakey

Lumakey (2 Echtzeit Lumakeys mit 3 Echtzeit Videospuren)

Umgekehrt angewandter Lumakey (2 Echtzeit Lumakeys)

> Chromakey ovaler 

Selektionsmodus

> zu keyendes Video  > Hintergrundvideo  > Chromakey Resultat 1 > Chromakey Resultat 2

> zu keyendes Video A > zu keyendes Video B  > Hintergrundvideo > Lumakey Resultat

> zu keyendes Video > Hintergrundvideo  > Lumakey Ergebnis > Lumakey-Ergebnis mit  
    neu gekeytem   
    Schachbrettmuster
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DV Storm 2 bietet die in der Industrie flexibelste 3D Bild-im-Bild-Bearbeitung - leistungsstarke 
Übergangskontrolle inbegriffen.
> Interaktive Vorschaumöglichkeiten für Positions-, Orientierungs-, Skalierungs- und Schatten-Konfiguration
> Vollständige Keyframe-basierte Timeline-Kontrolle für Position, Orientierung, Perspektive, Skalierung 

und Transparenz 
> Anschnitt- und Kanten-Kontrolle ermöglicht eine separate Kontrolle jeder einzelnen Kante sowie die 

Kontrolle über Farbe und weiche Kanten
> 3 Interpolations-Modi: Alle Keyframe-Gruppen können wie folgt interpoliert werden: konstant, linear 

oder kontinuierlich
> Die benutzerfreundliche Konfigurations-Kontrolle ermöglicht eine schnelle Konfiguration komplexer 

Übergänge, ohne Berücksichtigung von Start- und Ende-Punkten.
> Extrem hochqualitatives Anti-aliasing für weiche Ecken und eine klare Wiedergabe von 3D 

manipulierten Bildkanten. 
> Einfach zu benutzende Presets sorgen für perfekte Ergebnisse ohne zeitaufwendige Veränderungen 

vornehmen zu müssen.

> Echtzeit 3D Perspektive Bild-im-Bild mit Glanz- und Kanten-Effekten.

> 3D Perspektive Bild-im-Bild Setup

Echtzeit Bild-im-Bild / Pan & Zoom

DV Storm 2 bietet die in der Industrie flexibelste 3D Bild-im-Bild-Bearbeitung - leistungsstarke 
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Xplode für DV Storm : 
Echtzeit 2D und 3D Übergänge

Canopus DV Storm 2 beinhaltet Xplode für DV Storm – ein fortschrittlicher 3D Videoeffekt-Engine. Xplode 
Professional arbeitet mit der Canopus eigenen Effekt-Technologie und liefert atemberaubende, professionelle 
und hochqualitative Videoübergänge. Mit 26 Übergangsgruppen, Hunderten von Presets und unendlich vielen 
kundenspezifisch veränderbaren Optionen bietet Xplode Professional hoch entwickelte Leistungsfähigkeit für 
den professionellen Editor.

> Fly Away > Alpha-Wipe – Heart > Spinning Cube                      > Twist

Beste Leistungsfähigkeit

Xplode für DV Storm arbeitet direkt in Adobe Premiere und den Canopus Edit Applikationen, um zahlreiche 
komplexe Übergänge und Effekte in Echtzeit zu verwirklichen.

Erstellen von Originaleffekten
> Setzen von Keyframe-Punkten innerhalb aller Übergänge

> Verändern der Bewegungsrate zu jedem Zeitpunkt während des Übergangs

> Speichern von Keyframe-Effekten in eine Presetliste

> Konfigurierbare Beleuchtung ermöglicht Editoren die Position, die Intensivität und die Farbe einer Lich-
tquelle bzw. des Lichteinfalls zu bestimmen oder zu verändern 

> Innerhalb selektierter Übergänge, wird die Barriere statischer Schatten gebrochen, da man nun mit Xplode 
Professional Schatten ein sehr natürliches und realistisches Aussehen geben kann und die Schattierung 
gemäß des Lichteinfalls wiedergegeben wird.

> Import von 3D-Objekten von Lightwave und 3D Studio Max. Mit Xplode Professional können Anwender 
Anforderungs-spezifische 3D Effekte erstellen. Weitere spezifische Effekte werden durch die Unterstützung 
von .AVI, .BMP, .GIF, .WMP und .JPG-Formate möglich.

Selektieren Sie einige der nachfolgenden Übergangs-Kategorien, die 
alle über zahlreiche Presets verfügen
> Xplode 3D Standard – Ball Bounce, Billboard, Confetti, Conveyer, Cube Tube, Double Door, Fly Away, Page 

Peel, Ripple, Twist, Wave, Zoom

> Alpha Vapor Dissolves –  Wolken, Rauch und Wasser
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> Alpha Wipes – über 60 unterschiedliche Wipes wie z.B.: Beam Me up, Breaking Wave, Checker, Circles, Cur-
tains, Diamonds, Gravel Ring, Hearts Galore, Jaws, Layered Roll On, Mosaic Ripple, Muffins, Oil Slick, Quad 
Spots, Radar, Sandblast, Spiral Burst, Wash Away

3DRT-II Highly optimized 3D DVE’s

Blinds, Cube Spin, 3D Dissolve, Flip Over, Four Pages, 
Peel Away, Sphere, Single Door, Two Pages

> Xplode Übergangs-Setup

> Wash Away > Ball Bounce > Alpha Vapor - Changing Wind

> Confetti > Zoom > Alpha Wipes - Spiral in & out   

Canopus Intuitive 
Benutzeroberfläche

Die intuitive Benutzeroberläche von Xplode 
Professional’s „SmartConfig“ erleichtert den Einstieg 
enorm, da der Anwender auf einfachste Weise 
Übergänge gemäß seinen Anforderungen schnell 
und einfach verändern kann.

> Blinds > Four Pages

> Sphere> Peel Away

> 3D Objekt-Wipes  – Nutzen Sie 3D-Objekte, um ein Video B in das Video A übergehen zu lassen. Diese 
Effekte beinhalten: Airliner, Boom Box, Butterflies, Camera, Card, Cell Phone, Dice, F16, Golf Ball, Heart, 
Helicopter, Semi Truck, Sword

> Alpha Wipes über 60 unterschiedliche Wipes wie z.B.: Beam Me up, Breaking Wave, Checker, Circles, Cur-

Realtime Production Studio



10 11

Canopus Echtzeit Tools
DV Storm 2 beinhaltet ein beeindruckende Zusammenstellung von professionellen Tools, um dem Editor beste 
Kreativität für seine Projekte zu geben. Diese Tools beinhalten Waveform & Vectorskop-Darstellung, Echtzeit 
Audiofilter und Echtzeit Audio-Ausgabe PlugIns für Adobe After Effects, Adobe Photoshop und Lightwave 3D.

Video Tools
Waveform & Vektorskop
Bei der Verarbeitung und für die Beibehaltung der Videosignal-Qualität, die für 
Broadcast-Projekte notwendig ist, sind Messgeräte unerlässlich. Das Waveform- und 
Vektorskopmessgerät stehen bei der Farbkorrektur und bei den Filtern für Weißabgleich 
zur Verfügung. Die Filter für Weißabgleich verändern die Farbabstimmung durch 
Nutzung der weißen oder schwarzen Enden des Farbspektrums. 

>Waveform > Vectorskop  > Weißabgleich > Farbkorrektur

Echtzeit Video Ausgabe-Plugins 
Canopus bietet Echtzeit-Ausgabe-PlugIns für Adobe After Effects / Adobe Photoshop / Lightwave 3D

Audio Tools
Echtzeit Audio Tools
Canopus Echtzeit Audiofilter liefern Tools, wie z. B. grafische Equalizer, Delay, HighPass-Filter, Tonkontrolle 

u.v.m. in Storm Edit und Adobe Premiere.

Leistungsstarke Gema-freie Musikkreationen
Sonic Foundry ACID Style
ACID Style ist eine leistungsstarke Software, die Ihnen alles bietet, 

was Sie zur Erstellung Gema-freier Musik benötigen.

> Auswahl an über 600 Musik-Loops

> Erstellen Sie Musikstücke unter Nutzung der einfach zu bedienenden 
“Pick, Paint & Play“- basierten Benutzeroberfläche

> Nutzung unbegrenzt vieler Audiospuren

> Fly-In Soundeffekte, Muster und rhythmische Effekte 

> Speichern Sie Ihren Musik-Mix in zahlreichen gängigen Formaten ab, 
inkl. MP3, Real Audio ®, Windows MediaTM und WAV > Sonic Foundry ACID Style
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Encodierung in rasender Geschwindigkeit. DV Storm 2 umfasst Möglichkeiten für MPEG-Schnitt und 

–Rekompression, um Dateien editieren zu können, die bereits nach MPEG encodiert wurden. 

> MpegCutter – Cut, trim and re-export MPEG clips.

> MPEG – Schnitt, Kürzen und Re-Export von MPEG-Clips

> AV Splitter – Erstellt Elementary Stream-Dateien von Programstream-Dateien 
und trennt Audio und Video.

> MPEG-Re-Encoder – Re-konvertiert MPEG-Dateien mit hoher Bitrate zu Dateien mit 
niedriger Bit-rate in kürzester Zeit unter Nutzung des Hardware MPEG-Encodings.

> MpegExplorer – Ermöglicht eine detaillierte Ansicht aller MPEG-Dateien inner-
halb eines bestimmten Ordners

MPEG Encoding und Web Streaming
> Der neue Canopus MPEG-Encoder bietet eine Ausgabe als MPEG-1, MPEG-2 

(DVD kompatibel), VCD und SVCD direkt von der Timeline mit Anwender-spezi-
fisch veränderbaren Presets. 

> Encodierung zu Programm Stream (Audio und Video zusammen) oder Elemen-
tary Stream (Video und Audio getrennt) unter Anwendung konstanter (CBR) 
oder variabler (VBR) Bitrate 

> Für’s WebStreaming: Export von Real Video-, Windows Media für QuickTime 
Formate aus Storm Edit und Adobe Premiere

> Captured direkt nach MPEG-1, MPEG-2 und VCD entweder von 
analog oder DV mit der beiliegenden Software MediaCruise. 

 
DVD Authoring

DVD Produktionen waren bisher eine teures Vergnügen und 
benötigten spezielle und zeitaufwendige Autorensysteme. 

DV Storm 2 vereint ein Echtzeit DV-Schnittsystem mit einer 
DVD-Autorenlösung in einem System. Im Bundling-Umfang ist 
Ulead DVD Workshop, für eine hochqualitative Ausgabe von 
DVDs, VCDs und SVCDs enthalten und bietet Funktionen wie z. B. 
bewegte Menüs, spezielle Text-Effekte, Farbanpassung und Photo-
Diashows mit statischen Bildern und Audio. 

Das Erstellen von DVDs mit DV Storm 2 ist ein Kinderspiel. 
Encodieren Sie einfach nach MPEG2 direkt von der Timeline und 
importieren Sie die MPEG-2 Dateien in Ulead DVD Workshop für 
ein einfaches aber leistungsstarkes DVD-Authoring. Durch die 
mittlerweile erschwinglichen DVD-Rekorder für Ihren PC, wird die 
DVD zum bestmöglichen Distributions-Format für Videodaten. > Ulead DVD Workshop

MPEG Tools 

Canopus DV Storm beinhaltet die eigenen Canopus Media Technologien für höchstqualitative MPEG-

> Canopus MPEG 

Encoder options 

> MediaCruise 

> Canopus MpegCutter
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Product Specifications

> DV Storm PCI Bus Karte

Hardware MPEG Encoding
> Direktes Echtzeit-Capturing nach MPEG-1 

und MPEG-2
> MPEG-2 D1, Half-D1 und MPEG-1 Encoding
> Encodiert I,P,B Frames (MP @ ML, 

DVD-kompatibles Encoding)
> Bitrate 1-15MB/Sek. Kunden-spezifisch 

veränderbar (CBR/VBR)
> PAL (720x576)/NTSC (720x480), CCIR-601
> Prefiltering 4:2:2 zu 4:2:0
> Ausgabe von der StormEdit oder 

Adobe Premiere 6.5 Timeline
> Capturing mit MediaCruise
> Spezielle MPEG-Ausgabegröße ohne 

erneutes Rendering
> MPEG-1: Elementary und System Streams
> MPEG-2: Elementary und Programm Streams
> Audio: PCM WAV oder MPEG Layer II

Video Funktionen
> IEEE 1394 (4-pin)
> Composite video (CVBS),  RCA jack
> S-Video (Y/C), mini-DIN
> NTSC und PAL 

> IEEE 1394 (4-pin)
> Composite video (CVBS), RCA Buchse 
> S-Video (Y/C), mini-DIN
> NTSC und PAL 

> CCIR-601
> NTSC: 720x480 @ 29.97 fps 
> PAL: 720x576 @ 25 fps
> 16:9 Unterstützung
> DV/ DVCAM Untersützung 

Full-motion video via hardware overlay supported at 
standard NTSC and PAL frame rates.

Audio Features
> 2-channel 48 kHz 16-bit
> 2-channel 44.1 kHz 16-bit
> 2-channel 32 kHz 16-bit

> Standard RCA 

PCI Interface

Eingänge

    

Ausgänge

Video-Formate

Native DV
Audio I/O

Stereo Audio 
Ein/Aus

0 Lieferumfang

Hardware
> DV Storm PCI Bus Karte
> Installations-CD-ROM
> Benutzerhandbuch
> IEEE 1394 DV Kabel (4Pin-4Pin, 2m)
> Stereo Pin-Buchse zum RCA Audiokabel
> Composite nach S-Video Konvertierungs-Kabel

Software
> StormEdit
> Canopus DV Capture
> Canopus 3DRT-II
> Canopus Xplode für DV Storm
> Adobe Premiere Plug-In
> Video Out Plug-In für Adobe After Effects
> Video Out Plug-In für Adobe Photoshop
> Video Out Plug-In für Newtek Lightwave 3D
> Canopus MPEG Tools
> Canopus MediaCruise
> Sonic Foundry ACID Style
> Ulead DVD Workshop SE

0 Mindestsystemanforderungen

     (Für 1 Sek. Echtzeit-2D Übergang + bewegter Titel)

> Windows XP Home/ XP Professional/ 2000
> Intel Pentium III oder AMD Athlon Prozessor 700MHz 

oder höher*
> 1 freier PCI Steckplatz
> 256MB RAM
> AV-optimierte Videofestplatte (10MB/Sek. 

durchgängiger Datendurchsatz mindestens)
> 24Bit oder 32Bit Grafikkarte mit Hardware DirectDraw 

Overlay bei einer Auflösung von 1024x768
 *Auf unserer Webseite finden Sie die einzelnen Systemanforderungen 

0 Service und Support
> 3 Jahre Garantie

0 Produktspezifikationen

Spezifikationen

DV Storm SE Kunden, haben die Möglichkeit, zum vollen Funktionesumfang der DV Storm 2 upzudaten. 
Für ausführliche Informationen besuchen Sie unsere Webseite: www.canopus.de

© 2002 Canopus GmbH. Alle Rechte vorbehalten. Das Canopus Logo und DV Storm2 sind eingetragene Warenzeichen der Canopus Corporation. Alle anderen 

Warenzeichen auch eingetragene Warenzeichen sind Eigentum der jeweiligen Besitzer. Änderungen sind vorbehalten und bedürfen keiner vorherigen Ankündigung.
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